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Attendees
NOTE: Multiple SAP Concur product versions and UI themes are available, so this content might contain images or procedures that do not precisely match your implementation. For example, when SAP Fiori UI themes are implemented, home page navigation is consolidated under the SAP Concur Home menu.
Section 1:  Permissions

A company administrator may or may not have the correct permissions to use this feature. The administrator may have limited permissions, for example, they can affect only certain groups and/or use only certain options (view but not create or edit). 

If a company administrator needs to use this feature and does not have the proper permissions, they should contact the company's Concur administrator.

Also, the administrator should be aware that some of the tasks described in this guide can be completed only by SAP. In this case, the client must initiate a service request with SAP Concur support. 
Section 2:  Overview

For some expense types, such as business meals or entertainment, Concur Expense users may be required – sometimes for corporate reasons; sometimes for legal reasons – to identify all attendees associated with that expense. In some cases, each individual attendee must be listed. In other cases, it may be acceptable for the user to simply enter a count (number of unnamed attendees).

This guide describes how Concur Expense users, approvers, delegates, and proxies use the Attendees feature. It also describes how the administrator configures the feature.

Attendee Features Available to All Concur Expense Users

In the basic attendee feature, an Concur Expense user can add, edit, view, and remove attendees.

Optional (Configurable) Attendee Features

There are many optional features that the admin can configure to enhance the user experience and to ensure that the company is able to gather the desired (and required) attendee information.
General Configuration Options

General configuration options include:
· 20 custom fields available specifically for attendees

· Ability to track year-to-date attendee totals
Settings for Attendee Type
Settings specific to each attendee type to:

· Make all employees in a company available within the attendee search function for selection and inclusion as an attendee

· Have separate attendee forms for each attendee type 

· Allow attendee lists to be shared or private 

· Allow users to enter new attendees into Concur Expense

· Set the available attendee types for an expense type by excluding attendee types and only displaying the remaining attendee types

· Set a default attendee type for an expense type

· Allow users to enter the count (number of unnamed attendees) instead of having to identify and enter each individually – for a defined attendee type (used in conjunction with the similarly named expense type/policy setting)

· Have Concur Expense check for duplicate records when users add new attendees to Concur Expense

· Define the search criteria available in the attendee section

· Allow users to search and import attendees from an external source
Refer to the Fetch Attendee Web Service information on http://developer.concur.com.
Settings for Policy and Expense Type
Settings specific to each policy and expense type to:

· Allow users to view the amount of the expense allotted to each attendee

· Allow users to edit the amount of the expense allotted to each attendee

· Allow users to account for attendees who were invited but did not attend ("no shows")

· Allow users to enter the count (number of attendees) instead of having to identify and enter each individually – for a defined expense type and policy (used in conjunction with the similarly named attendee type setting)

· Include the Concur Expense user as an attendee by default
· Suppress the Add New Attendee button for an expense type
Features Specific to Expense Groups
Features specific to Expense groups:

· Attendee types available for this group to use

· Configurable view of information in attendee lists (columns available for view)

· Audit rules relating to attendee totals and frequency of attendance
Other Configuration Options

Other configuration options:
· Allow the administrator to import attendee lists from other applications

· Allow users to import attendees (using an Excel worksheet) into a specific expense

· Show users My Team tab (direct reports or users with the same approver) while searching for attendees.

Section 3:  What the User Sees - on the Expense Report Page

This section describes the tasks the user can complete using the expense report page. Many of the same tasks can be completed on the user's Profile page. The information about the Profile page is discussed in What the User Sees - in Profile in this guide.

The Attendees link appears on the Details tab for an expense whenever an expense type requires attendees.
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Using Attendees, a user can: 

· Add an existing attendee or attendee group to the expense 

· Search for an existing attendee or attendee group

· Add any employee at their company, not just those in Favorites or previously used (configurable)

· Edit or view attendee information 

· Create a new attendee (configurable) 

· Create an attendee group

· Remove an attendee from an expense

· Account for "no shows" (configurable)

· Enter a count (number of unnamed attendees; configurable)

· Import attendees (using an Excel worksheet) into an expense (configurable)

· Search for and import attendees from an external source (configurable)

NOTE: The administrator can also restrict – by attendee type – the attendees that a user can create, edit, view, or search for, as described in the configuration portion in this guide.

Adding a Favorite Attendee or Attendee Group to an Expense

There are two ways for a user to add a favorite attendee or attendee group to an expense if the attendee or group is already in their favorites (as listed in Profile > Profile Settings > Request Settings > Favorite Attendees).
Adding a Favorite Attendee

Favorite attendees can be added to an expense from two tabs on the Attendees pages: Recent Attendees and Attendee Groups.

Recent Attendees Tab
First, click the Attendees link and then click Add on the Attendees page. Users can then click the Recent Attendees tab. 
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A list of attendees added to recent expenses displays. Users can click the Search All Attendee History link to view or search a list of all recent attendees.
Attendee Groups Tab
First, click the Attendees link and then click Add on the Attendees page. Users can click the Attendee Groups tab and then the Favorites link to add or search a list of all favorite attendees.
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On the Favorites pages, users can add or search for attendees to add to an expense.
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Search for Favorite Attendees
To search for recent or favorite attendees, users can use the Search field from the Favorites page.

To access the search field, users can:

· From the Recent Attendees tab, click the Search All Attendee History link

· From the Attendee Groups tab, click the Favorites link
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In the Search field, the user can search by typing one or more letters of an attendee's name. They can select an attendee and click Add to List to add them to the attendee list for the expense.
Adding an Attendee Group

Users can add attendee groups from the Attendee Groups tab by selecting one or more groups and clicking Add to List.
Copying Attendees from a Request (from Concur Request)
The user can copy attendees from a request associated with an expense report directly to that report's expense entry, provided the entry allows attendees. 

With the request open, a user adds a request to an expense report by clicking the Create Expense Report button.
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When Concur Expense detects that the request entry has attendees, it automatically copies them from that request directly to an expense entry. This behavior saves the user entry time and allows the user to work with the attendees just as if they were available in Concur Expense. If the user wants to make changes, by clicking on the Attendees link, they can add, remove, create groups, or copy attendees again from the request.
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Searching for an Attendee 

When the user clicks Add to add attendees, from the Add Attendees page, they can click More Search Options to refine their search results. 
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The user clicks the appropriate attendee type, enters part of the name, etc., and clicks Search. The search results appear. They can select the attendee(s) and then click Add to List to add them to the list of attendees for the expense.
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NOTE: When searching for attendees in Concur Expense, the search results have a limit of approximately 5,000 attendees, so the search results will be limited to the first 5,000 attendees returned by the search.

If you are searching an external source for attendees using the Fetch Attendee Web Service, the attendee search results for the Fetch Attendee Web Service has a limit of 100 attendees. In this scenario, the search results will be limited to the first 100 attendees returned by the search. For more information, refer to Fetch Attendee Web Service on http://developer.concur.com.
Searching for Employees by Email Address and Country
The default advanced search view for employee attendees automatically includes the addition of Email address and Country fields. These filter options allow users to narrow search results, making identification of employees accurate and efficient.
This filter is useful for the following:

· Accurate identification of employees, particularly for those with the same first and last name

· Optional inclusion of inactive employees in attendee searches

NOTE: This functionality is specific to the employee (SYSEMP) attendee type and does not apply to other attendee types like business guest or spouse.
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In addition to selecting advanced search parameters, user must also select one of the following fields: First Name, Last Name, or Email Address. Completing these fields optimizes the search and narrows the criteria used to return relevant results.

Once the search is run, the search results page also includes a Country column, displaying any country associated with the attendees returned by the search.
For the Email address and Country fields to display automatically as searchable fields, the Employee option selected in the Attendee Type list should be mapped to SYSEMP.
This functionality is automatically available when the attendee setting Allow automatic creation of employees as attendees (SYSEMP attendee type) is enabled. This setting is typically enabled, unless explicitly disabled during implementation to meet unique business needs.
For information about how to enable this setting, refer to Step 6 in the Configuration-Overview and Procedures section of this guide.
Optional Configuration

Copy down may now be configured for Employee attendee type (SYSEMP) attendee fields.
If there are fields on an employee record that are beneficial to include in an attendee search (such as cost center, legal entity, or office location), admins can configure the additional fields using copy down functionality from the employee record to the attendee record. This provides additional information for use in searching for employees as well as display of attendees linked to an expense.
This new copy down option may allow simplification of the management of employee attendees by removing the need to use an attendee import to update the attendee data of the SYSEMP attendee type.

· We highly recommend admins check the form field configuration for all expense attendee forms and specifically for any copy down configuration on the Employee Attendee Form referenced for the SYSEMP attendee type.

· Admins, please also refer to the Configuration Report > Attendee Forms link accessible from the Expense Admin page.

Searching by all Available Employees at a Company

The system can be configured to search all employees at a company for selection and inclusion as an attendee (and simultaneous auto-creation of an attendee record for that employee). To configure this feature (if not already available at your site), refer to Making All Employees Available in an Attendee Search in the Configuration section of this document.


NOTE: Users can search an external source for attendees and import them into Concur Expense. Refer to the Fetch Attendee Web Service information on http://developer.concur.com.

Searching Employees on My Team

The system can be configured to display the My Team link on the Attendee Groups tab. My Team displays a list of employees that are related to the current user in the following ways: 
· The employees share the direct approver with the user. 

· The employees report directly to the user. 
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NOTE: This feature requires that the Employee attendee type (SYSEMP) be configured as a shared list. For more information, refer to the Including All Employees in a Company in the Attendee Search section of this guide.
Concur Expense uses the configured approval hierarchy to determine the team structure. Delegates will see the My Team employees for the users that they are delegating for, not their own team. 
Using Recent Attendees

When the user clicks Add on the Attendees page, the Recent Attendees tab automatically displays. 
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To view a full list of attendees, users can click the Search All Attendee History at the bottom of the page.

The user selects one or more attendees and then clicks Add to Expense. 
Editing or Viewing Attendee Details

A user can edit attendee information only if the user originally added the attendee to Concur Expense. Otherwise, the user can view – but not edit – attendee information. 

In the Attendees section, the user clicks the desired attendee's name. The Attendee Details dialog appears. 
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When done, the user clicks Save.

The following information may display (read-only) on this page (not shown in the sample above): 

· Audit rule exception message: If an audit rule exception has been generated for this attendee

· Totals (including, but not limited to): 

· Total amount YTD (total spend on this attendee by the entire company year-to-date) 

· Total Amount Previous Year (total spend on this attendee by the entire company last year) 

· Employee Amount YTD (total spend on this attendee by the current user year-to-date) 

· Employee Amount Previous Year (total spend on this attendee by the current user last year) 

Note the following:

· This total per attendee will begin to aggregate at the point the option is configured; it will not retroactively include expenses submitted prior to its activation. However, for those importing managed lists of attendees, a starting year-to-date total may be imported when creating a new attendee record.

· For more information about importing attendees, refer to Import a List of Attendees in the configuration section in this guide.

· Whether any or all these totals are visible to users is configurable, as described in configuration portion of this guide. 

· The attendee types that are visible to users (by groups) is configurable, as described in configuration portion of this guide.

Viewing and editing attendee information can also be completed by the user in Profile. Refer to What the User Sees - in Profile in this guide.

Editing or Viewing Amounts
Viewing Amounts 

Whether users can edit – or even view – the amounts allotted to attendees is configurable, as described in the configuration portion of this guide.

Attendees section with read-only totals:
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Attendees section with editable totals:
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NOTE: If you add a number of additional fields to this display, move the Attendee Count column to the left for easier viewing on laptop or netbook devices - use the Form Fields tab (in Forms and Fields) to do this.

Changing Amounts
When attendees are added to an expense, the system automatically distributes the amount of the expense evenly across attendees. 

If the configuration allows the user to edit amounts, the user can click in the Amount column and change the value, if necessary.
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When the user clicks out of the Amount column, Concur Expense redistributes the remaining portion of the expense evenly between the remaining attendees.

Understanding How Concur Expense Distributes and Redistributes Amounts

Keep the following in mind about changing amounts: 

· Concur Expense initially distributes the amount of the expense equally across attendees. That is, if the expense amount is 100 USD and there are two attendees, Concur Expense allots 50 to each attendee. 

· If a user adds or removes an attendee, Concur Expense redistributes the amounts. In the above example, if the user removes one attendee, then the remaining attendee is allotted the full 100. If the user adds another attendee (so now there are two again), Concur Expense redistributes again, allotting 50 to each. 

· If the user manually changes an amount, Concur Expense will not later change that amount while redistributing. 

· Assume that the user edited the amount of attendee A to be 30 and the user let Concur Expense automatically adjust attendee B's amount to be 70. If the user now adds attendee C, Concur Expense will redistribute 70 across attendee B and C; Concur Expense will not change attendee A, which remains at 30. 

· Assume that the user edited the amount of attendee A to be 30 and manually changed attendee B's amount to be 70. If the user now adds attendee C, Concur Expense allots zero to attendee C. The user must manually adjust amounts to account for attendee C; Concur Expense will not automatically change the amount for attendee A or B. 

· Amounts cannot be edited for expenses marked as personal or the "parent" portion of an itemized expense. 
For information about how Concur Expense handles amounts and copy down, refer to Copy Down Itemization Information to Attendees in this guide.

Creating a New Attendee 

From the Attendees tab, the user can create an attendee using the Create New Attendee link. 
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The Create New Attendee dialog appears.
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The user selects the desired type from the Attendee Type list. The page refreshes with the appropriate fields for the selected attendee type.

The user completes the remaining fields and clicks either Save or Save & Add Another.

Concur Expense then checks for duplicate attendees. If it finds one or more potential duplicates, the user is prompted to use the existing attendee information (if the attendee that the user is adding and the duplicate are, in fact, the same person) or to continue adding the attendee (if the attendee that the user is adding and the duplicate are not the same person). 

The new attendee is added to the expense and is added to the user's favorites list.

Note the following:

· The user can change the Attendee Type value for an attendee added to a report or request up to the point at which the report or request is submitted, after which this value is locked down by the system.
· The attendee duplicate type check by default is limited to attendees of the same type, however it can be expanded to all attendee types on the Settings tab of the Attendees page in Expense Admin.

· The company can also decide whether to implement "carry-forward." It is similar to copy down but it copies data from one attendee to another (for example, company name) when the user is adding attendees, as described in the configuration portion of this guide.

· Whether users can add new attendees is configurable, as described in the configuration portion of this guide.

By default, the New Attendee button appears to the user. The administrator can suppress this button in the Attendees section to prevent a user from adding an attendee – forcing the user to search for the attendee first, ensuring the attendee is not already in the system.

NOTE: This option affects only the Attendees section of the New Expense (or Expense) tab – not the other attendee "grids" (like Profile favorites) that contain a New Attendee button. 

Removing an Attendee from an Expense

The user selects the check box of the desired attendee, then clicks Remove. The attendee is removed from the expense. 
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Removing the attendee from the expense does not remove the attendee from the user's favorites list. Amounts are redistributed, as described in Understanding How Expense Distributes and Redistributes Amounts in this guide.

Creating an Attendee Group

A user can create an attendee group using an existing expense on an expense report, either unsubmitted or submitted. To do so, the user selects the desired attendees and clicks Create Group.
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In the Create Group dialog, the user enters a group name and clicks Save. 
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NOTE: The group names do not have to be unique.

Creating an attendee group can also be completed by the user in Profile. Refer to What the User Sees - in Profile in this guide.

Accounting for "No Shows"
A user can account for No Show attendees. For example, assume that an event was planned for three attendees, prepaid in the amount of 300 USD, which means each of the attendees would be allotted an amount of 100. Now assume that one of the attendees cancelled at the last minute so only two attendees were present. By default, each attendee would be allotted an amount of 150. By using the No Show feature, the user can indicate that one attendee was a no show so that other attendees reflect the correct amount of 100 each.

Totals when not accounting for "no shows":
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Totals when accounting for "no shows":
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The remaining 100 is not allotted to the absent attendee and does not affect the absent attendee's annual totals.

The No Show feature is not available for expenses marked as personal or the "parent" portion of an itemized expense.
NOTE: Whether users can use the No Show feature is configurable, as described in configuration portion of this guide. 

Entering a Count for Unnamed Attendees
In some cases, it is acceptable for the user to enter a count ​– number of unnamed attendees – instead of listing each attendee individually. For example, assume that the user purchased a gift for a doctor and the "group" gift for the employees in the doctor's office.
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NOTE: Whether users can enter "counts" instead of entering all attendees individually is defined by expense type/policy and attendee type, as described in the configuration portion of this guide.

Copy Down Itemization Information to Attendees
Assume that a user itemizes an expense with attendees and your system is configured to copy down the attendees to the itemizations. If so, attendees entered at the parent expense can copy down to any itemization with attendees. On the initial creation of the itemizations, the attendees present on the parent expense will copy to the itemization. If the user then makes changes to the attendees on the parent expense (for example, add an additional attendee), the user will be asked if they want to copy the change to the itemizations.

In this example, there are three attendees, each allotted one third ($50) of the itemization ($150).
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When the user adds a fourth attendee to the parent expense, the itemization is automatically adjusted. In this example, each attendee is allotted one quarter ($37.50) of the itemization.
Important!

Be aware that - when Concur Expense added the fourth attendee to the itemization, it added up the individual attendee amounts (from the three attendees) and then divided by 4. If the user had made manual adjustments to the amounts, the user must adjust them again. Because of the way Concur Expense handles amounts, its only option is to divide the amounts equally. 

NOTE: Whether amounts are copied down is configurable, as described in configuration portion of this guide. 

Additional Attendee Information

Expense List

The user can view attendee information on the expense report page by clicking the Attendees link to view and Attendee summary pop up. 
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When they click the View Attendees link, they can see a detailed list of attendees with counts and amount totals.
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Additional Attendee Information - Attendee Detail View

Change Columns

There are several places in Concur Expense where attendee information is presented in tables, such as the Attendees section of an expense.
By default, the information that the user sees in these tables includes the attendee name, type, company, and title. The administrator can customize this information. The administrator can add any of the following:

· First Name

· Last Name

· Middle Initial

· Suffix

· Custom 1-20

· Attendee Entry Custom 1-5 

· Total Amount Previous Year

· Total Amount YTD

· Attendee Count 

· Status (used primarily with the Fringe Benefit Tax feature in Australia and New Zealand)

· Refer to the Concur Expense: Fringe Benefits Tax (FBT) Setup Guide for more information.
Once the new "view" configuration is created, it is implemented by assigning it to one or more Concur Expense groups.
NOTE: Entry-specific information such as amount per attendee, attendee count, status and Attendee Entry Custom 1-5 will only show on the table when viewed from within an expense.
Example - Add a Field

For example, by default, the Attendees section of the New Expense (or Expense) tab contains the Attendee Name, Attendee Title, Company, and Attendee Type columns. (Visibility of the Amount column is configurable.)

Assume that a company is in the pharmaceutical industry where it is important for the user to know the state in which the attendee (doctor) practices. Further assume that the administrator added a custom field (renamed State) to the attendee form. The administrator can also add that same field to the display, using the Attendee Detail View form.
[image: image31.png]Favorite Attendees

Attendees | Attendee Groups

Find every atiendee where Last Name

| Atendoo ame »

<] [geavan

Advanced Search

o | Atencee Tt | company | Atencee Type G
n Brooks, Josef IT Manager Medicoco Business Guest
O Brooks, Pamela Dr. HCP Providers cA
O Brown, Terry L This Employee
0 DeMille, Pat IT Manager Medicoco Business Guest
[m] Doe, John Business Guest
n Doretto, Tessa or. HCP Providers cA
| Pagel 1%





When the administrator adds or removes a column, the change appears in the profile settings and all grids where attendees are listed for an expense.
For more information, refer to the Configuring the Attendee Detail View section of this guide.

Using the Personal Attendee Import Feature

The personal attendee import benefits users who must list a large number of attendees for events such as seminars or department functions. The attendee import uses a Microsoft Excel spreadsheet to import attendees. It is recommended that no more than 500 attendees be included in a single import.
NOTE: Concur Expense supports up to 500 attendees per expense. This limit is due to a combination of configuration elements for the expense detail form, the attendee type, and related attendee form. Because of the constraints of these configuration elements, expenses with more than 500 attendees may or may not function correctly. SAP cannot guarantee that any list of attendees greater than 500 will import successfully to Concur Expense. Attempting to import more than 500 attendees could result in issues opening the expense report or an individual expense item.

Your company may allow you to use the import. When Concur Expense is configured to use the attendee import feature, the Import Attendees tab appears on the Add Attendees dialog.
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The user clicks the Import Attendees button. The Attendee Import dialog appears. 
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Using this dialog, the user accesses an Excel worksheet (formatted with the attendee fields) and saves it to his/her computer or network. 
NOTE: The import file template is language specific. The user must download the template while logged in using the same language it will be uploaded under.
The user opens the worksheet in Excel, enters the attendee records (up to and not over 500 attendees, as previously recommended), and saves. 
The user then imports the competed worksheet into Concur Expense. Once imported, Concur Expense displays the attendee information. The user reviews the information for accuracy.

Then:

· If the information is correct, the user clicks Next.

· If the information is not correct (and the user notices the error), the user clicks Cancel, corrects the worksheet, and imports again.

In the next step, Concur Expense checks for errors, for example, missing "required" information. Any attendees that appear on this page will not be imported.

Then:

· If the user wants the attendee to be imported, the user clicks Done (which cancels the process), corrects the worksheet, and imports again.

· If the user does not want the attendee to be imported (perhaps the user has decided to add the attendee later - manually, without using the import), the user clicks Next.

In the next step, Concur Expense checks for possible duplicates by comparing the attendees on the worksheet to attendees already in the system. If the import identifies possible duplicate attendees, a list of possible duplicate attendees is displayed in the Import Attendees section of the dialog. Duplicate attendees in the attendee import are resolved one attendee at a time.

Then:

· If a possible duplicate (from the worksheet) truly is an existing attendee, the user selects the attendee in the Import Attendees list, clicks View Duplicates, selects the existing attendee in the Duplicates section, and then clicks Use Selected Attendee. 

· If the possible duplicate (from the worksheet) is not an existing attendee, the user selects the attendee in the Imported Attendee list, and then clicks Use Selected Attendee. 

Note the following:

· Attendees that are missing required fields can be imported. The attendees must have at least the Last Name and Attendee Type field completed. The user can add all other required fields to the attendee record after import. 

· Attendees that are in your Favorites are not treated as duplicates, providing that the attendee record appears once, and only once, in your favorite attendees.

· When the system checks for possible duplicates, it is first looking for an exact match on the External ID. The External ID is unique to each attendee. It is generally the attendee ID obtained from the client's HR or CRM system and is not likely to be included in the worksheet. It then looks for duplicates based on the fields configured for duplicate check for that attendee type.

· For more information about the External ID, refer to External ID - Required for Imported Changes and Deletions in the configuration section in this guide. 

· If Concur Expense finds more than one possible duplicate (so that several names are listed in the Import Attendees list), the user deals with each one individually.
· Attendees of type SYSEMP (Employee), where the user is not allowed to create a new attendee record, can now be imported, and will be matched to one existing employee record. 

· Attendee types where the user may not create a new attendee record but may search for attendees from a company-managed list may be included in the import file. The system will attempt to find a match with existing attendees in the system and will fail the record if no match is found.

· The attendee duplicate type check by default is limited to attendees of the same type, however it can be expanded to all attendee types on the Settings tab of the Attendees page in Expense Admin.

When done, the user clicks Next. The final Import Attendees page appears.
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On this page, note the following definitions:

· Attendees added to the attendee list for your expense: A total count of the number of attendees successfully added from your imported list.
· Attendees skipped - already listed for your expense: A skip occurs if an attendee is added to an expense and then the user imports the same worksheet with the same attendee to the same expense.
· Attendees that could not be imported - data errors: The system detected that at least one required field was missing and the user elected to not import that attendee.
· Duplicate attendees resolved: As described previously, the system compares information from the attendees on the worksheet to the attendees already in the system. If the External IDs are not an exact match, the user is asked to indicate if the imported attendee truly is a duplicate. 

· For more information about the External ID, refer to External ID - Required for Imported Changes and Deletions in the configuration section in this guide.

When the user clicks Close, the attendees are imported into the expense.
Section 4:  What the User Sees - in Profile

Attendees Tab

When the user goes to Favorite Attendees, they can manage their favorites list on the Attendees tab. The favorites list also displays under the Attendee Groups tab when adding new attendees to an expense. 
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NOTE: This list is not necessarily all the user's available attendees; it includes only the user's favorites.

NOTE: The attendee types that are visible to users (by groups) are configurable, as described in configuration portion of this guide.

The user can use this tab to: 

· Create a new attendee 

· Edit or view attendee information 

· Delete / Hide an attendee 

· Find an attendee 

Note the following about the information that appears on this page:


	Information
	Description

	User Name
(attendee type of This Employee)
	The user's name appears automatically in this list (depending on the configuration). 

	Annual Total
	On this page, the attendee's name, title, company, and attendee type always appears. The Annual Total column may appear, based on the company's configuration. If so:

· The amount shown is the total amount spent company-wide in the current calendar year for that attendee (not only from the current user)
– and – 

· The currency used is: 

· The currency that is set in the import record, if the attendee was imported
– or – 

· The same as the user's reimbursement currency, if the attendee was added by a user 

NOTE: There are two ways to add the total column to the Attendees tab (both described in the configuration section of this guide). 

· One involves the attendee Settings page; that setting adds the Annual Total column to the Attendees tab.

· The other option involves using the Attendee Detail View form. Adding the Attendee Total YTD field to the view will provide the same result but will also add this information to several other places, like the Attendees section of the New Expense (or Expense tab), the Search Attendees page, etc. 

· Refer to Additional Attendee Information - Attendee Detail View in this guide.

	Audit Icon
	A red audit icon appears if an audit rule exception has been generated for that attendee.


Creating a New Attendee

To add a new attendee to the user's attendee favorites list, the user clicks New Attendee, completes the Add Attendee page, and then clicks Save or Save & Add Another.
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NOTE: The company can also decide whether to implement "carry-forward." It is similar to copy down but it copies data from one attendee to another (for example, company name) when the user is adding attendees, as described in the configuration portion of this guide.

Editing Attendee Information

A user can edit attendee information only if the user originally added the attendee to Concur Expense. To do so, on the Attendees tab, the user clicks either:

· The attendee's name (link) 
– or –

· The check box to the left of the attendee's name and clicks Edit
The user edits the desired information and clicks Save. 

Deleting / Hiding Attendees

When using this feature, the attendee is actually deleted from Expense only:

· If the user originally added the attendee to Concur Expense
- and - 

· If the attendee has not been associated with an expense 

In all other cases, the attendee information is simply removed (hidden) from the user's attendee favorites list and can be located using the using the Advanced Search link. 

To delete, the user selects the check box associated with the attendee and clicks Delete. 

NOTE: The attendee can also be deleted from the Favorites tab of the Attendees section of the New Expense (or Expense tab).  

Finding Attendees

The user can search their favorites list using the Find every attendee where area. The user completes the fields and clicks Go. The search results appear.

NOTE: Be aware that this "find" option is searching the attendees in the favorites list. To locate attendees that the user has deleted (removed), the user clicks Advanced Search. 

Attendee Groups Tab 

Using Profile, users can manage their groups of favorite attendees. Users can:

· Create, edit, and delete groups

· Send a copy of one or more groups to another Concur Expense user

Create a Group of Favorite Attendees

Note the following:

· Attendees that a user adds to a group must first be in the user's favorites list. 

· Each group can have as many as 500 individual members.

· A user can create an unlimited number of groups.

· An attendee can belong to more than one group.

To create a group, the user clicks Profile > Profile Settings > Favorite Attendees (left menu) and then clicks the Attendee Groups tab. The user clicks Add New. 
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The user's list of favorite attendees appears.

The user selects each attendee to be included in the group and types a name for the group in the Group Name field.

NOTE: The name does not have to be unique, but it is a best practice to have unique group names.
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The user clicks Save Group. The selected attendees now appear in a group.
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Edit a Group

The user uses the edit feature to:

· Add more attendees to an existing group 
- or - 

· Remove attendees from an existing group

On the Attendee Groups tab, the user selects the group and clicks Edit.
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The user makes the desired changes and clicks Save Group.

Delete a Group

When a user deletes a group, the group is dissolved; the individual attendees are still available in the user's favorites list. If a user deletes an attendee from the favorites list and that attendee is in one or more groups, a confirmation message appears.

To delete, on the Attendee Groups tab, the user selects one or more groups and clicks Delete.

Send a Copy of a Group to Another User

A user can send a copy of one or more groups to another user. The group then appears immediately on the recipient's Attendee Groups tab; all individual attendees in the group also appear on the recipient's Attendees and Favorites tabs. 

To send a copy to another user, on the Attendee Groups tab, the user selects one or more groups and clicks Send Copy.
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In the Send a copy of the selected group(s) dialog, the user finds the desired recipient and clicks Send.
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NOTE: The selected group(s) can be sent to only one recipient at a time.

Note the following:

· Remember - this is a copy. Any modifications that the original owner makes to the group will not affect the recipient; any modifications that the recipient makes to their copy will not affect the original owner's group.

· Since the group names do not have to be unique, the copy cannot overwrite or otherwise destroy data in the recipient's group list.

· If the recipient does not have access to an attendee type, any attendees of that type will not be included in their copy of the group.

Attendee Detail View

You can add additional information to the attendee grids (tables) in Profile as described in Additional Attendee Information - Attendee Detail View in this guide.
Section 5:  Delegates, Proxies, Approvers, and Processors

Delegates and Proxies

All of the features described here for Concur Expense users are also available to delegates and proxies.

Attendee Types Restricted by Groups

If the administrator has defined attendee types by groups, when a delegate or proxy accesses attendee information on behalf of a report owner, the attendee types available are based on the types defined for the report owner's group.

Approvers and Processors

· IMPORTANT! Before reading this section, review Understanding How Expense Distributes and Redistributes Amounts in this guide to understand the relationship between manual changes to amounts and Concur Expense's automatic redistribution of amounts among attendees.

Like most forms and fields, the attendee forms and fields can be configured so that it is either read-only or editable (modify) for the approver and/or processor. If so, modify means: 

· The approver and/or processor can add attendees to and remove attendees from an expense. 

· Neither the approver nor the processor can manually adjust the amount of the expense allotted to each attendee. However, if the approver or the processor lower the total amount of the expense, then the individual attendee-allotted amounts are adjusted proportionally.

· If the approver and/or processor add or remove an attendee and:

· If the user has not manually changed any amounts, then Concur Expense will automatically redistribute the amounts equally among all attendees.

· If the user manually changed some but not all amounts, then Concur Expense will redistribute the amounts over the attendees whose amounts the user did not change as well as any new attendees added by the approver or processor. 

· If the user manually changed all amounts, then Concur Expense cannot redistribute the amounts. On save, an exception is created because the amounts no longer balance. Though the approver/processor is encouraged to return the report to the employee for editing, the report can be approved/processed.  

Attendee Types Restricted by Groups

If the administrator has defined attendee types by groups, when an approver or processor accesses attendee information on behalf of a report owner, the attendee types available are based on the types defined for the report owner's group.

Section 6:  Configuration – Overview and Procedures

This portion of the process requires the role of Concur Expense Configuration Administrator. 

Different Processes for Different Options

Clients wanting to take advantage of the extended attendee functionality may opt-in to the following features. The optional features are applied in these ways:

· Global: Applies to all expenses that require attendees

· By attendee type: Set based on the attendee type

· By expense type within the policy: Set based on the expense type and policy, using the Expense Types page

· By Expense Group: Configured and then applied to one or more Concur Expense groups
The attendee features are listed in the table below and are described in detail on the following pages.


	Configured by Feature 
	Global
	Attendee Type
	Expense Types
	Group

	20 custom fields available specifically for attendees
	X
	
	
	

	Ability to track year-to-date attendee totals
	X
	
	
	

	Separate attendee forms for each attendee type
	
	X
	
	

	Allow attendee lists to be shared or private
	
	X
	
	

	Allow or prevent users to enter new attendees into Expense
	
	X
	
	

	Have Expense check for duplicates when users add new attendees to Expense
	
	X
	
	

	Duplicate checks are performed across all attendee types
	X
	
	
	

	Define the fields that Expense uses to perform the duplicate check
	
	X
	
	

	View the amount of an expense allotted to each attendee
	
	
	X
	

	Edit the amount of an expense allotted to each attendee
	
	
	X
	

	Account for attendees who were invited but did not attend ("no shows")
	
	
	X
	

	Include the Expense user as an attendee by default
	
	
	X
	

	Suppress the Add New Attendee button by expense type
	
	
	X
	

	Set a default attendee type for an expense type 
	
	
	X
	

	Allow only some attendee types to be chosen for an expense type by excluding all others
	
	
	X
	

	Allow users to enter the count (number of unnamed attendees)
	
	X
	X
	

	Import of attendee lists by administrator from other applications
	X
	
	
	

	Import of attendee lists by users
	X
	
	
	

	Allow the automatic creation of an attendee record for the current employee (SYSEMP attendee type)
	X
	
	
	

	Create audit rules relating to attendee totals and frequency of attendance
	
	
	
	X

	Auto-generate the External ID, used if importing lists of attendees
	X
	
	
	

	Restrict attendee types by user group
	
	
	
	X

	Configure the Attendee Detail View (form)
	
	
	
	X

	Search for and import attendees from external source

NOTE: This option requires additional configuration. The external sources are:

Concur Salesforce Connector: Refer to the Shared: Concur Salesforce Connector Setup Guide. 

Fetch Attendee Web Service: Refer to the Fetch Attendee Web Service information on http://developer.concur.com.
	
	X
	
	


The Basic Configuration Process

These steps are described briefly here and described in detail on the following pages:

Step 1: Define the attendee forms and fields.

Step 2: Edit the Attendees field on the Expense Entry form (optional).

Step 3: Configure the Attendee Detail View (optional).
Step 4: Edit the attendee-related expense types.

Step 5: Add additional attendee types and select attendee settings.

Step 6: Include all employees in a company in the attendee search.
Step 7: Create the desired attendee audit rules (optional).
Step 8: Configure the Excel worksheet to be used for personal attendee imports (optional).

Step 9: Import a list of attendees (optional).

Step 1: Defining the Attendee Forms and Fields

Overview: Attendee Forms and Fields

In this step, you configure one or more forms used for attendees. You can create as many attendee forms as necessary, for example, one for each attendee type if desired, or for example by company type, by using the Health Care Professional (HCP) attendee form.

General Notes about Attendee Forms

· Expense provides a default attendee form. To create new forms, make a copy of the default form and then edit the copy.

· Concur Expense also provides company-specific forms, such as the Health Care Professional (HCP) attendee form.

· An administrator can create as many attendee forms are needed.

· Attendee forms are administered at Administration > Expense > Expense Admin > Forms and Fields.
· Once the Expense Attendee form type is selected, the list of forms is displayed. The forms can be expanded to display the currently configured fields. 

· Use the Attendee Detail View form type to provide additional information in the most common attendee grids (tables) as described in Additional Attendee Information - Attendee Detail View in this guide.

· Refer to the Concur Expense: Forms and Fields Setup Guide for general information about forms and fields.

General Notes about Attendee Fields

· For the most part, attendee fields are like all other custom fields
· Refer to the Approvers and Processors section in this guide for information about using the "modify" field attribute for approvers and processors.

· The attendee fields are listed below. 
The attendee fields are:

	Field Name
	Description

	Attendee Count
	Total count of attendees by this attendee type

	Attendee Name
	Attendee's name

	Attendee Title
	Attendee's work title

	Attendee Type
	Business Guest, Spouse, and so on

	Company
	Attendee's company

	Company Category 1 Authorized Amount Previous YTD
	Total pre-authorized spend on this attendee on selected expense types by the entire company last year

	Company Category 1 Authorized Amount YTD
	Total pre-authorized spend on this attendee on selected expense types by the entire company year-to-date

	Company Category 1 Submitted Amount Previous YTD
	Total spend on this attendee on selected expense types by the entire company last year

	Company Category 1 Submitted Amount YTD
	Total spend on this attendee on selected expense types by the entire company year-to-date

	Company Category 2 Authorized Amount Previous YTD
	Total pre-authorized spend on this attendee on selected expense types by the entire company last year

	Company Category 2 Authorized Amount YTD
	Total pre-authorized spend on this attendee on selected expense types by the entire company year-to-date

	Company Category 2 Submitted Amount Previous YTD
	Total spend on this attendee on selected expense types by the entire company last year

	Company Category 2 Submitted Amount YTD
	Total spend on this attendee on selected expense types by the entire company year-to-date

	Created By (Private List)
	Defines the "owner" of the attendee information

· For more information, refer to Private vs Shared Attendee Lists in this guide.

	Currency Key
	As defined in the import, if imported; or same as the user's reimbursement currency, if the attendee was added by a user 

	Custom 1-20
	Custom fields as defined by the company 

	Attendee Entry 
Custom 1-5
	Custom fields used to collect information specific to the attendee on the current expense; this data can be extracted using the Attendee Detail extract

	Employee Amount Previous Year
	Total spend on this attendee by the current user last year

· For more information, refer to Amount Fields (Edit Attendee and Details) in this guide.

	Employee Amount YTD
	Total spend on this attendee by the current user year-to-date

· For more information, refer to Amount Fields (Edit Attendee Details) in this guide.

	Employee Category 1 Authorized Amount Previous YTD
	Total pre-authorized spend on this attendee on selected expense types by the current user last year

	Employee Category 1 Authorized Amount YTD
	Total pre-authorized spend on this attendee on selected expense types by the current user year-to-date

	Employee Category 1 Submitted Amount Previous YTD
	Total spend on this attendee on selected expense types by the current user last year

	Employee Category 1 Submitted Amount YTD
	Total spend on this attendee on selected expense types by the current user year-to-date

	Employee Category 2 Authorized Amount Previous YTD
	Total pre-authorized spend on this attendee on selected expense types by the current user last year

	Employee Category 2 Authorized Amount YTD
	Total pre-authorized spend on this attendee on selected expense types by the current user last year

	Employee Category 2 Submitted Amount Previous YTD
	Total spend on this attendee on selected expense types by the current user last year

	Employee Category 2 Submitted Amount YTD
	Total spend on this attendee on selected expense types by the current user year-to-date

	External ID
	Required for imported attendee records

· For more information about the External ID, refer to External ID - Required for Imported Changes and Deletions in this guide.

	First Name
	Attendee's first name

	Last Name
	Attendee's last name

	Total Amount Previous Year
	Total spend on this attendee by all users company-wide last year

· For more information, refer to Amount Fields (Edit Attendee Details) in this guide.

	Total Amount YTD
	Total spend on this attendee by all users company-wide year-to-date

· For more information, refer to Amount Fields (Edit Attendee Details) in this guide.

	Status
	Used primarily with the Fringe Benefit Tax feature in Australia and New Zealand

· Refer to the Concur Expense: Fringe Benefits Tax (FBT) Setup Guide for more information.


Private vs. Shared Attendee Lists

If an attendee list is private, then:

· Only the current user can use attendees from this list

· Only the current user can search this list 

· If the user is allowed to add attendees to the list, then Concur Expense will search only this user's attendees for duplicates

If an attendee list is shared, then:

· Any user can use attendees from this list

· Any user can search this list 

· If users are allowed to add attendees to the list, then Concur Expense will search all users' attendees for duplicates

The Created By (Private List) field, which is not visible to the user, has two functions. It is used by Concur Expense:

· To identify the "owner" of the attendee for editing or deleting; for example, in order for a user to edit attendee information or delete an attendee, the user must be the owner

· To identify if an attendee list is private or shared

Whether or not you include this field as one of the search fields and the duplicate search fields ultimately defines whether attendees list are private or shared.

Further explanation: Remember, the Created By (Private List) field is always hidden and is always populated with the user's user ID (cannot be changed; cannot be deleted). So, if you add the Created By (Private List) field to the search fields or the duplicate search fields, the field is always part of the search or duplicate search. 

· In the case of the search fields, the system will find only those attendees who have that same user ID in the Created By (Private List) field. In other words, the system will not search outside of the user's attendees. So, to keep a list private, add the Created By (Private List) field – users will not find each other's attendees. 

· In the case of duplicate search fields, the system will match only attendees who have that same user ID in the Created By (Private List) field. In other words, the system will not search outside of the user's attendees for duplicates.
Summary: What do you want to accomplish?

	Searching for Attendees 

	Type of List
	Description
	Configuration

	Shared
	I want each user's attendee list to be shared for this attendee type. 

That is, I want users to be able to search for attendees with this type created by anyone in the company or imported from a master list by the company.
	When defining forms, on the Forms tab:

1. Select the form type of Expense Attendee.

2. Select the desired form.

3. Click Modify Form.

4. In the Modify Form dialog, ensure that Created By (Private List) field is not checked.
· Refer to Configuring Attendee Forms and Fields in this guide.

	Private
	I want each user's attendee list to be private. 

That is, I want users to be able to search for attendees with this attendee type only in their own attendee list.
	When defining forms, on the Forms tab:

5. Select the form type of Expense Attendee.

6. Select the desired form.

7. Click Modify Form.

8. In the Modify Form dialog, ensure that Created By (Private List) field is checked.
· Refer to Configuring Attendee Forms and Fields in this guide.


	Searching for Duplicates 

	Type of List
	Description
	Configuration

	Shared
	When a user adds an attendee with this attendee type, I want Concur to search for duplicates among all attendees with this type created by anyone in the company or imported from a master list by the company.
	Click Administration > Expense > Attendees, on the Attendee Types tab:

9. Select the attendee type.

10. Click Modify.

11. In the Attendee Type dialog, in the Fields for duplicate search list, do not select Created By (Private List). 
· Refer to Adding Additional Attendee Types and Working with Other Attendee Settings in this guide.

	Private
	When a user adds an attendee, I want Concur to check for duplicates only among attendees with this type in the user's attendee list.
	Click Administration > Expense > Attendees, on the Attendee Types tab:
12. Select the attendee type.

13. Click Modify.

14. In the Attendee Type dialog, in the Fields for duplicate search list, select Created By (Private List).
· Refer to Adding Additional Attendee Types and Working with Other Attendee Settings in this guide.

	Additional optional setting for duplicate attendee searches

	Shared or Private
	The two options above restrict the search to the same attendee type. 

I want to search all attendee types for duplicates.
	15. Configure Shared or Private as described above.

16. Click Administration > Expense > Attendees.

17. On the Settings tab, select (enable) the Check for attendee duplicates across attendee types check box.
· Refer to Adding Additional Attendee Types and Working with Other Attendee Settings in this guide.


Amount Fields (Edit Attendee Details)

The amount fields that appear on the Fields tab provide the accumulated totals (in profile and in the Edit Attendee Details dialog in Concur Expense) if you add these fields to the desired attendee form.

This example shows the Employee Amount YTD and Total Amount YTD fields added to the attendee form for the Business Guest attendee type. 
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Procedure: Configuring Attendee Forms and Fields

Access Forms and Fields

  To access the attendee forms and fields:

1. Click Administration > Expense > Expense Admin > Forms and Fields.
2. In the Form Type list, click Expense Attendee.

Use the Forms Tab - General
 To make general changes on the Forms tab:

3. To view the fields on the form, click the [image: image44.bmp] to the left of the form name.
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4. To create another form, click an existing form and click Copy Form.

5. To add additional fields to the form:

· Click the form.

· Click Add Fields.

· Select the desired fields.

· Click Add Fields.
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Use the Forms Tab - Search Fields

 To define the Search Fields:

6. To define the search fields (the fields that appear on the Search Attendees dialog), on the Forms tab, click the form.

7. Click Modify Form. The Modify Form dialog appears.
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8. Select the desired fields.

9. Click Save.
Use the Form Fields Tab - General

 To make general changes on the Form Fields tab:

10. To change the characteristics of a field:

· Either:

· Double-click the desired field.
– or 

· Click the desired field and click Modify Form Fields.

[image: image48.png]Forms and Fields

FomType: | Expense Attendee

Forms || Form Fields || Fietds | Connected Lists || Conditional Fieids || Vatidations

e | sean| x[Q

Form Field Name | Requirea | sequence

© Copy of Default Attendee Form

‘Attendee Type Yes 1
Last Name Yes 2
First Name No 3
‘Attendee Title No 4

" Company No 5
Created By (Prvate List) Yes B
© Default Attendee Form

© Default Employee Attendee Form

© Default HCP Attendee Form





· Make the desired changes.

· Click Save.

11. To remove a field:

· Select the field.

· Click Remove Form Fields.

12. To change the sequence of the fields, drag-and-drop a field to the new location.

Configure Carry-Forward

When a user manually enters attendee information (name, company, job title, etc.) and the attendees are (for example) from the same company, the user must repeat the company name for each attendee. However, you can configure the system so the attendee information is automatically copied (carried forward) from one manual entry to the next. 

First, the company decides which attendee fields, if any, use the carry-forward feature.
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Typically, a company would have attendee type, company, and any custom fields carry forward. 

This feature works when the user adds attendees in Profile > Profile Settings > Favorite Attendees or from the expense. However, the information is carried forward only when the user clicks Save & Add Another; it does not carry-forward on Save.

 To configure carry-forward:

The feature is implemented like copy down. 

13. On the Fields tab, either:

· Double-click the desired field.
– or 

· Click the desired field and click Modify Form Fields.

14. In the Default Value Type field, click Copy Down.
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15. In the Copy Down Source field, click Expense Attendee.

16. In the Field field, click the name of the source field (which would be the same name as the field you are currently editing).

17. Click Save.

Step 2: Editing Expense Entry Forms for Copy Down 

Overview: Copy Down

Attendees (and amounts) entered at the parent expense can copy down to any itemization with attendees.

For information about how the feature works, refer to Copy Down Itemization Information to Attendees in this guide.

The configuration process is:

· Edit the Attendees form field on the affected Expense Entry form(s)

· Ensure the itemization form is correct for the affected expense type(s)

Procedure: Modify the Attendees Field

NOTE: If your configuration has several Expense Entry forms that contain the Attendees field, then all must be modified. In this case, we have only one - Entertainment.

 To modify the Attendees field:

18. In the Form Type list, click Expense Entry.

19. Click the Form Fields tab.

20. Click the Entertainment form to expand it.

21. Either:

· Double-click the Attendees field.
– or – 

· Click the Attendees field and click Modify Form Fields.

The Modify Form Fields dialog appears.
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22. In the Itemization Field Source, click Parent Expense.

23. Click Save.

Procedure: Verify the Itemization Form for the Expense Type

Ensure that the expense types use the proper form for itemizations. For example, in this case, the Business Meal expense type use the Entertainment form (which includes attendees) for the parent expense but uses the Default form (no attendees) for the itemizations. In order for the attendees to copy down, the Entertainment form must be used for the itemizations.

 To verify or change:

24. Click Administration > Expense > Expense Admin.
25. Click Expense Types (left menu). The Expense Types page appears.
26. Click the expense type (in this case, Business Meals).

27. Click Modify.
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28. Make no changes on the General step; click Next.

29. On the Policies step, select the appropriate form in the For an Itemized Entry use this form column (in this case, Entertainment).
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30. Click Next to navigate through the remaining pages.

31. Click Done.

Step 3: Configuring the Attendee Detail View

Overview: Attendee Detail View

Use these steps to provide additional information or suppress display of elements in the most common attendee grids (tables) as described in Additional Attendee Information - Attendee Detail View in this guide.

The configuration steps are:

· Configure the view (form)

· Assign the form to one or more Concur Expense groups

Procedure: Configure the View

In the examples below we will add as custom field (Custom 01 renamed State) to the view.

 To configure the view to add a new field:

32. Click Administration > Expense > Expense Admin.

33. Click Forms and Fields (left menu). The Forms and Fields page appears.
34. From the Form Type list, click Attendee Detail View.

[image: image54.png]Forms and Fields

Form Type: |

Expense Entry
Forms | Form | Expense Report Header
Expense Allocation
Expense Aftendee

Expense Detail View
Form Field Na

‘alidations
] | Sea

Attendee Detail View
Expense Car @
Employee

Cash Advance

Tax





· IMPORTANT: This view will be assigned to one or more groups. Unless the changes will be assigned to all groups, consider making a copy of the form so you still have the original with the original configuration.

35. Then, on the Forms tab (for the desired form or copy), click Add Fields.
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36. Select the desired field and click Add Fields. The new field is added.
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Note the following:
· Like any other form, you can use the Forms Fields tab to modify field properties, change the sequence, and remove fields.

· The Fields, Connected Lists, and Validations tabs are not available since they do not apply to "view" forms. 

 To assign to an Concur Expense group:

37. Click Administration > Expense > Expense Admin > Group Configurations. The Group Configurations page appears.

38. Click the desired group and click Modify.
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39. In the Attendee List Form field, select the desired view form.
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40. Click Save.

Step 4: Editing the Attendee-Related Expense Types

Overview: Understanding Attendee Count Configuration

When allowing user-entered attendee count, two settings (expense type/policy and attendee type) are used together.

· The expense type/policy setting indicates whether the user can enter a count for this particular expense type, for example, Business Meals.
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· The attendee type setting indicates whether the user can enter a count for this particular attendee type, for example, Business Guest.
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If at least one attendee type is configured to be editable, then at least one expense type must be configured to be editable (and vice versa). If not, the column never displays (and, hence, the count is never editable).

Assume in this example:

· The Business Meals expense type is configured to be editable.

· The Business Guest attendee type is configured to be editable.
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For each Business Meal expense type, the Attendee Count column appears and:

· The field is editable for each Business Guest attendee. 

· For any other attendee type, the field is not editable.

For each expense type that is configured for attendees and is other than Business Meal, the Attendee Count column does not appear, regardless of attendee type.

Moving the Attendee Count Column for Visibility

The Attendee Count column is part of the Attendee Detail View form and can be moved to a different location within the grid, for example, to the left for greater visibility for laptop and notebook users. 
To move the field, in Forms and Fields, select the Attendee Detail View form from the Form Type list. Then, like any other field, drag and drop the Attendee Count to the new location.
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Procedure: Editing Expense Types

 To edit an attendee-related expense type:

41. Click Administration > Expense > Expense Admin.

42. Click Expense Types (left menu). The Expense Types page appears.
43. Either:

· Double-click the desired expense type.
– or –

· Click the desired expense type and click Modify.
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44. Click Next enough times to access the Attendees step.
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45. Select or clear the desired check boxes, as described below.


	Field
	Description

	Show Cost per Attendee
	Select (enable) this check box to allow users to view the amount of the expense allotted to each attendee. 

If selected, the Amount column appears in the Attendees section of the New Expense (or Expense) tab. 

	Allow users to edit the Cost per Attendee
	Select (enable) this check box to allow users to edit the amounts in the Amount column.

	Allow users to enter the count of "No Shows"
	Select (enable) this check box to allow users to account for no shows – attendees who were invited but did not attend.

If selected, the No Shows field appears in the Attendees section of the New Expense (or Expense) tab.

	Allow users to edit the count of attendees
	Select (enable) this check box to allow users to enter a count (number of unnamed attendees) for this expense type.

If selected, the Attendee Count column appears in the Attendee section of the New Expense (or Expense) tab.

NOTE: Remember, this feature is used in conjunction with attendee type settings. Refer to Procedure: Configuring Attendee Types in this guide.

	Include user as an attendee by default
	If you select this check box, Concur Expense automatically adds the user as an attendee when the user accesses the attendees section the first time (when no attendees are assigned to the entry).

Once attendees are assigned or if the user removes their name from the attendee list, Concur Expense does not attempt to add the user again.


46. Click Next and then Done.

47. Use these same steps to edit all desired expense types.

Overview: Restricting Attendee Types by Expense Type

To reduce the possibility of selecting the wrong attendee when working with expense types, the admin can filter the available attendee types. This is done by suppressing the display of selected attendee types under the Exclude Attendee Types column when modifying expense types within a policy.

NOTE: If the form assigned to an expense type does not include the Attendees field, the feature cannot be used because the Exclude Attendee Types column (explained below) will not appear.

The attendees available for selection are filtered at the following points in Concur Expense:

· New Attendee

· Attendee Search

· Attendee Groups

· Favorite Attendees

· Attendee Import for Expense Type

· Does NOT impact Attendee functionality in the My Profile page

Exclusion of Attendees - Special Cases

· Attendee Groups: At the Attendee Group level, if all attendees are of a type excluded for the combined Policy and Expense Type, then none will be available for selection. 

· User Attendee Import: In the Excel-based User Import, these excluded attendees will import successfully, but each will be flagged and manual removal is required to ensure successful report submission. 

Procedure: Filtering Attendee Types for Expense Types by Exclusion

 To exclude attendee types for selected expense types:

48. Click Administration > Expense.

49. Click Policies (left menu). The Policies page appears.
50. Click the desired policy.

51. Click Expense Types.
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52. Configure the expense type to exclude attendees by navigating to the Exclude Attendee Types and noting the status:

· Add: Appears when no attendees have been excluded.

· Modify (#): Appears when <#> number of attendees are excluded.
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53. Click either Add or Modify <#>, the Exclude Attendee Types dialog appears.
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54. In the Exclude column, either:

· To exclude the attendee type, select (enable) the associated check box.
– or –

· To include the attendee type, clear (disable) the associated check box.

55. Repeat for each expense type you will exclude attendee types for.

56. Click Save.

NOTE: If the option is not available, the Attendee field must be added to the form for the given expense type.

Overview: Setting a Default Attendee Type for an Expense Type

A single attendee type can be specified as the default attendee type for an expense type when selecting and working with an expense in a report. 

Procedure: Setting the Default Attendee Type for an Expense Type

 To set the default attendee type for an expense type:

57. Click Administration > Expense > Expense Admin.

58. Click Policies (left menu). The Policies page appears.
59. Click the desired policy.

60. Click Expense Types.
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61. Either:

· Double-click the desired expense type.
– or –

· Select the desired expense type and click Modify Properties.

The Modify Expense Type Properties dialog appears.
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62. Select a single attendee type from the list.

NOTE: The list of available attendees may be limited if some attendee types have been excluded for the expense type.

63. Click Save.

Overview: Suppressing the New Attendee Button by Expense Type
NOTE: This feature is not available within the new user experience for Concur Expense.
By default, the New Attendee button appears to the user. The administrator can deactivate this button in the Attendees section to prevent a user from adding an attendee – forcing the user to search for the attendee first, ensuring the attendee is not already in the system.
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Procedure: Suppressing the New Attendee Button by Expense Type
In this example we will use Policies to suppress the Add Attendee button by the Airfare expense type.

 To configure the view to suppress the Add Attendee button:

64. Click Administration > Expense > Expense Admin > Policies.
65. Select the desired policy. 

66. Click Expense Types.
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67. Click the desired expense type. 

68. Click Modify Properties. The Modify Expense Type Properties dialog appears.

69. Clear the Display the Add New Attendees button from the attendee table check box.
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70. Click Save.

Step 5: Adding Additional Attendee Types and Working with Other Attendee Settings

There are two pages: Attendee Types and Settings
Overview: Attendee Types 

On the Attendee Types page, you can:

· While adding or editing attendee types:

· Define the fields that are used in "duplicate" searches

· Define whether to allow users to add attendees of this type

· Define whether to allow users to enter an attendee count of this type

· Define the data source to search for that attendee type 

· Inactivate attendee types

"This Employee" Attendee Type

Concur Expense uses this attendee type when it automatically adds Concur Expense users as attendees. This is a system attendee type, so it cannot be inactivated. 

NOTE: The automatic creation feature can be turned off, however it is recommended that it remains on. Refer to the information about the attendee Settings tab.

On the Edit Attendee Type page:

	Field
	Description

	Attendee Type
	This Employee

	Attendee Type Code
	SYSEMP; cannot be edited

	Expense Attendee Form
	Default Attendee Form

	Fields for duplicate search
	External ID and Created By (Private List)

	Allow users to add attendees of this type
	No; cannot be edited

	Allow users to edit the count for this type
	No; cannot be edited


Procedure: Configuring Attendee Types 

 To access the attendee types:

Click Administration > Expense > Expense Admin > Attendees. The Attendees page appears.
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 To modify an attendee type:

71. On the Attendee Types tab, either:

· Double-click the desired attendee type.
– or –

· Select the desired attendee type and click Modify.

The Attendee Type dialog appears.
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72. Complete the appropriate fields.

	Field
	Description

	Attendee Type Name
	Change the name as desired.

	Attendee Type Code
	Change the code as desired. The code can be 1 to 8 alphanumeric characters, all uppercase, no spaces.

	Expense Attendee Form
	Select the desired attendee form.

	Fields for duplicate search
	Select the field(s) that will be used to check for duplicates.

NOTES: 

· If the intent is for your users to have private attendee lists, then include the Created By (Private List) field as a duplicate search field for this attendee type. 

· If you plan to have the system check for duplicates across attendee types, note that the system will successfully check for duplicates across attendee types only if the duplicate check fields are the same on all attendee types.

	Data Source for Attendee Search
	Select the data source used when searching for attendees of this type.

NOTE: This field is used by the Fetch Attendee Callout. If you are using this callout, select the system that you configured in the Register Application Connectors page of Web Services Admin. 

· Refer to the Fetch Attendee Callout information on http://developer.concur.com.

	Default Search for Attendees
	Select the default search when searching for this attendee type to optimize the experience: 

Default Simple – This choice prompts the user with the type-ahead field where the user can enter first or last name of the attendee and provides access to the advanced search.

Default Advanced –This choice prompts the user with the advanced search options and provides access to the simple search. 

Advanced Only – This choice provides the user with the advanced search and does not provide access to the simple search. This option is required for external attendee searches (API), or when the company has a very large number of attendees and the simple search responds very slowly or cannot be used.

NOTE: While the setting is available to all expense admins, the effects of this setting are only visible in the NextGen UI. End users in the existing legacy UI will continue to see Quick Search as the default regardless of what the admin sets as the default search per attendee type.

	Allow users to add attendees of this type
	Select this check box to allow users to add attendees with this attendee type.

NOTE: If you are using the Fetch Attendee Callout, this check box will be cleared and not editable.

	Allow users to edit the count for this type
	Select to allow users to enter a count (number of unnamed attendees) for this attendee type. 

IMPORTANT: This option is used in conjunction with the expense type setting. Refer to Overview: Understanding Attendee Count Configuration in this guide.


73. Click Save.

 To add a new attendee type:

74. On the Attendee Types tab, click New. The Attendee Type dialog appears.

75. Complete the fields as described in the previous section about editing existing attendee types.

76. Click Save.

 To deactivate an attendee type:

Note the following about deactivating an attendee type:

· When you deactivate an attendee type, all attendees with that attendee type are also marked as inactive and are no longer available for users to include on an expense.

· An attendee type that has been deactivated cannot later be made active.

· If you deactivate an attendee type and then later want to use it again, create a new attendee type. You cannot use the same name as the original. You can, however, modify the original and rename it. Then, you can create the new attendee type using the original name of the deactivated attendee type.
NOTE: Deactivating an attendee type will also deactivate every attendee of that type so that they may no longer be selected for use on an expense. Deactivating an attendee type containing a massive number of attendees may require assistance from SAP Concur support due to the large number of records that must be altered. Please contact support if deactivation of an attendee type is not successful.
77. On the Attendee Types tab, select the desired attendee type(s).

78. Click Deactivate. 
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Overview: Settings 

On the Settings tab, you can:

· Define the expense types that will be included when calculating attendee totals

· Define whether the Annual Total column displays in Profile
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· Define whether attendee types are restricted by user groups

· Define whether duplicate attendee searches happen across attendee types

· Define whether to allow Concur Expense to automatically create an attendee record (SYSEMP attendee type) for the current user

· Define whether to have the system generate an External ID for attendees manually added by users

· For more information about the External ID, refer to External ID - Required for Imported Changes and Deletions in this guide.

· Define whether the user sees the My Team tab on the Attendee Search dialog.

· Define Invoice-specific settings

· For more information, refer to the Invoice: Attendees Setup Guide.
Annual Total Column

If you choose to display the Annual Total column in Profile, be aware that:

· The amount shown is the total amount spent company-wide for that attendee (not only from the current user) for the selected expense type(s)
– and –

· The currency used is:

· The currency that is set in the import record, if the attendee was imported
– or – 

· The same as the user's reimbursement currency, if the attendee was added by a user

There is another way to add this column to this page. Refer to Additional Attendee Information - Attendee Detail View in this guide.

Exchange Rates Required

In order for the system to maintain totals for attendees, currency conversion may be required. The amount allotted to each attendee is calculated in the user's reimbursement currency. If the attendee currency is different from the user's reimbursement currency, then the system must convert the amount (in the user's reimbursement currency) to the amount in the attendee currency. In order for that conversion to be successful, the appropriate exchange rates must be imported.   
· If the Exchange Rates feature is activated and the user's reimbursement currency is included in the Exchange Rates import – converted to the attendee currency – then conversion takes place and the attendee totals are adjusted accordingly.
· If the Exchange Rates feature is not activated or if the appropriate currency has not been imported, then the user sees a message that briefly explains the issue and refers the user to your company's Concur Expense administrator.

For more information, refer to the Concur Expense: Currency Admin Setup Guide.

Procedure: Configuring Settings

 To change settings:

79. On the Attendees page, click the Settings tab. 
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80. Complete the appropriate fields.

	Field
	Description

	Expense Types to be included in the annual total of cost per attendee
	Select the expense types that will be included when calculating annual totals for attendees.

NOTE: If you do not select any expense types, the annual total will not be calculated.

	Include Invoice Expense Types in Annual Total of cost per attendee
	INVOICE ONLY: When the administrator selects this setting, all the expense types selected in the setting below will be included in the annual total of cost per attendee. This setting is cleared (disabled) by default.

	Invoice Expense Types to be included in the annual total of cost per attendee
	INVOICE ONLY: This setting contains a list of all the expense types that the administrator can select. When the administrator selects one or several expense types in this list, the amount from these expense types will be included in the total for a given attendee.

	Display My Team in advanced search options
	Select to display the My Team tab to the users when searching for attendees. The My Team tab contains the following employees:

· Employees with the same direct approver.

· Employees that are direct reports of the user.

· Refer to Searching Employees on My Team in this guide.

NOTES: 

· This feature may be confusing to users if your default Expense approver assignments are not aligned with your team structure.  

· This feature requires two additional attendee settings:

· Allow automatic creation of employees as attendees (SYSEMP attendee type) must be enabled. Refer to below in this table for more details.

· Employee attendees are a shared list under the SYSEMP attendee type. For more information, refer to the Procedure: Part 4 – Configure SYSEMP Attendee Type section of this guide. 

	Allow users to add attendees from meetings via email to Concur (*.ics files)
	No longer supported

	Display attendee total for calendar year
	Select if desired.

	Enable attendee type group management
	Select to define the attendee types available to different user groups.

· Refer to Attendee Types by User Groups in this guide.

	Check for attendee duplicates across attendee types
	Select to expand the attendee duplicate check to all attendee types. Clear to keep the duplicate check limited to attendees of the same type.

NOTE: The system will successfully check for duplicates across attendee types only if the duplicate check fields are the same on all attendee types.

	Allow automatic creation of employees as attendees (SYSEMP attendee type)
	ON by default; change if desired.

NOTE: The system will automatically generate a record for each Concur Expense user but only once the user takes one of these actions:

· The user opens a new expense form where the user is required to be added by default.

· The user completes a 'This employee' attendee type search from the Attendee section of the New Expense (or Expense) tab or from profile.

· The user completes a quick search or a favorite search from the Attendee section of the New Expense (or Expense) tab.

At the same time the user is added to the attendee list, the External ID field is populated with the user's Employee ID. 

· Refer to Including All Employees in a Company in the Attendee Search in this guide.

	Generate an External ID when a new attendee is created by a user
	Select to have the system create an external ID.

· For more information about the External ID, refer to External ID - Required for Imported Changes and Deletions in the configuration section in this guide.

	Audit Rule Group By Field for Expense Reports
	Select the custom field that will be used when totaling the attendee information for audit rules. If no field is selected, all expenses will be used.
NOTE: Once a selection is made and saved, this field becomes read-only. This is the expected behavior of the system, as totals already accrued are based on this configuration. Since totals are over periods of time, changing this has a material impact on already-accrued values. Please contact Concur Support if you require changes.

	Category Group 1 for Attendee Totals

Category Group 2 for Attendee Totals
	Select the expense types that will be included when calculating annual totals for attendees. 

You may create two different expense type groupings. Once these are created, you can add the total fields to the Attendee Details dialog. 

· Refer to the Configuring Attendee Forms and Fields section of this guide for more information on defining the attendee fields. 

NOTE: Once the types are configured, you will be unable to change them on this page. Contact SAP Concur support to make any changes. If you make changes to this page after attendee information has been saved, the attendee totals will not update with the new types. Any new attendees created after the change will use the new types for annual totals.


81. Click Save.

Overview: Attendee Types by User Groups

The administrator can define (or restrict) attendee types to specific groups. So, when a user adds, edits, views, or searches for an attendee, only the specified attendee types for that user's group will be available. For example, perhaps users in a Sales group can select and manage client attendees where non-Sales users cannot. 

This way, different groups of employees can see a restricted - and more appropriate - set of attendee types.

NOTE: One case may occur rarely - If an attendee is added to an entry and if that specific attendee type is later made inactive for the user's group and if the user later opens the entry, that attendee's information will no longer be editable by the user.

Procedure: Configuring Attendee Types by User Groups

The configuration includes two parts: 

· Attendee setting: One-time process to turn on the feature 
· Group configuration: Completed for each group
 To set the Attendee Setting option:

82. On the Settings tab, select (enable) the Enable attendee type group management check box.
[image: image78.png]Attendee Types | Settings

Expense Types to be ncluded i the annusltota of cost per
attendes:

Display My Team in scvance sesrch options:

Al users to ad stendees from mestings via emailta [
Concur (*ics fles)

Display attendee total for calencir yes:

Check for atende cupicates across attendes types: [

Allow sutomatic crestion of empioyees a5 atiendess
(SYSENP attendes type)

Generste an External D when a new attendes i created by a [

At Rl Group By Field for Expense Reports:
At Rl Group By Field for Authorizaion Resuests:
it Rl Group By Feld for Reguests:

Cateaory Group 1 for Atiendee Totaks:

Cateaory Group 2 or Atiendee Totas:

Expense Type Group 1 fo Attendee Toal:

Expense Type Group 2 or Atiendes Totals:





83. Click Save. Now a new column - Attendee Types - appears on the Group Configurations page.
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 To assign attendee types to groups:

84. On the Group Configurations page, click the Modify link in the Attendee Types column for the group you want to affect. The Configuration for group dialog appears.
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All attendee types appear except No Shows and This Employee, since they are system attendee types and cannot be inactive.

85. Select the check box for all attendee types that should be active for the group.

Note the following - not all types can be activated/inactivated:

· If an attendee type is set to Active at the parent group level, it will remain active at the child group level and cannot be changed to Inactive. 

· If the attendee type is set to Inactive at the parent group level, it can be overridden at the child group level and set to Active.

86. Click Save.

Step 6: Including All Employees in a Company in the Attendee Search

You can make every employee at your company available within an attendee search for ease of selection and addition to the report. When the employee is added, an attendee record is automatically created if no record already exists. 

Procedure: Part 1 – Confirm Auto-Create Attendee Record is Enabled

In this step you will verify that the setting to auto-create Attendee records is enabled. 

· Before proceeding with changes after initial implementation, ensure that, if the setting is not selected, why this is the case at your site. It is critical to understand why the setting is not enabled before altering the setting (it is selected by default) - there may be a strategic or system reason for inactivating it and that must be understood before proceeding.

 To verify and enable the Attendee Settings "Allow automatic..." setting:

87. From Administration > Expense > Expense Admin > Attendees, click the Settings tab. 

88. Select the Allow automatic creation of employees as attendees (SYSEMP attendee type) check box.
89. Click Save.
Procedure: Part 2 – Attendee Types and Employee Attendee Records

In this step, the existing attendee type Employee is renamed and saved to a more descriptive naming convention for your users.

 To rename and save the Employee attendee type:

90. On the Attendee Types tab, click Employee and click Modify. The Attendee Type dialog appears.
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91. Rename this attendee type, as each attendee type name must be unique - suggested changes based on Concur users:

· All Employees are Concur Users
Rename as "Employees (inactive attendee type)" to clearly show the user that, on selection of this attendee type, they are now searching across all employees using an inactive attendee type (see Step 3, next).

· Some Users are Concur Users, But You Want to Search Everyone
Rename as "Employees (not using Concur)" - this name instructs the user they are selecting employees "outside" of Concur users who are not yet associated with Concur (by way of attendee records in Concur Expense).

92. In the Fields for duplicate search list, ensure that Created By (Private List) is not selected.

93. Click Save.

Procedure: Part 3a – Inactivate the Employee Attendee Type if All Concur Users

If you know that all employees you want in an attendee search are also Concur users, then best practice is to inactivate the "Employees (not using Concur)" attendee type renamed in Step 2 so that it is no longer available for selection by the user.

If you are making this change after you have been collecting production data for a period, consider inactivating this attendee type and creating a new one. Doing this performs a user-wide "fresh start" for their employee attendee records by inactivating all existing Employee attendee type records.

 To deactivate the Employee attendee type:

94. On the Attendee Types tab, click Employees (not using Concur) and click Deactivate.
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95. Click Yes in the confirmation dialog box that appears.
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NOTE: It is important to note that inactivating any attendee type will inactivate all attendees of that type. This will remove these records from every user's Favorites and Favorite Groups, so prior notice of this change is suggested to explain the new behavior to your users. 

Benefits of Inactivating - Standardizing Employee Records

The benefit of inactivating all of the existing and many-times duplicated Employee-Attendee records is to standardize your employees each to a single record. This allows you "cleaner" Reporting data, and precision of use for employees in any attendee role. The disadvantage is that your users will need to rebuild their favorite employees list over time as mentioned above, and re-add employee records into their existing attendee groups.

Procedure: Part 3b – Add a New Attendee Type

In this step, you will add a new attendee type using the identical name of the attendee type you deactivated in Step 3a.

NOTE: Since the attendee type name and code must both be unique in the list, you are prevented from creating another with the same values. For the purposes of this exercise, you will simply edit an existing record to change its name (only) and thus make the old name once again available for use. 

For example, if you changed the Employee attendee type to "Employees (not using Concur)" and then deactivated it in Step 3a, you may now rename this deactivated attendee type to "Employees (no longer used)", save that change, and create a new attendee type using the name "Employees (not using Concur)" which is active and may be immediately put into use.

 To add a new attendee type:

96. On the Attendee Types tab, click New.

97. Enter "Employees (not using Concur)" as the new attendee type name, and a different attendee type code, such as EMPLOYES, not to exceed the limit of 7 characters.

98. Select the additional fields to meet your company's needs (as described earlier in this guide) - they make look similar to the figure below:

[image: image84.png]Attendee Type x

stendee e [Empoyee ot using Conur J

atensee e [epLovee ]
Cooe

Exserse e ot tarnFrm
-

Fields fordupicate | Atendee Tite, Company, Created B (Private Lis), First1|
search: -

Data Souce o [ Goncur
Attendee Search

ossutseventor (et s
it

Allow users o add )
aftendees of this
type:

Alow users o edit
the count for this
type:





99. Click Save. 

Procedure: Part 4 – Configure SYSEMP Attendee Type

In this step, the SYSEMP attendee type is configured for attendee search.

 To configure the SYSEMP attendee type for attendee search:

100. Under Attendees > Attendee Types tab, select SYSEMP under Attendee Type Code.

101. Click Modify and rename the attendee type to Employees or similar name that best represents those employees who are users of Concur.

102. Under Expense Attendee Form, select Default Employee Attendee Form to make this a shared list.

Discussion: This can utilize any attendee form that you have created for this purpose that is configured as a shared list (that is, Created By is not selected in the form search attributes under Modify Form). If you have not created a special Attendee form for Employees, the Default Employee Attendee Form will correctly set the configuration to allow this to be a shared list for attendee searches.

103. Under Fields for duplicate search, adjust Fields for duplicate search for use with a shared list by selecting and clearing duplicate search field selections:
· Remove (clear the check box): Created By (Private List)

· Add (select the check box): First Name, Last Name, Company
(Note that an additional field is required in addition to Name fields; the Company field option meets this requirement)

The dialog box should appear similar to the figure below:
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104. Click Save.

 To finish with Forms and Fields:

105. Click Administration > Expense > Forms and Fields.

106. In the Form Type list, click Expense Attendee.
107. Select the attendee form you assigned to the SYSEMP attendee type.

108. Click Modify Form.

109. Clear (disable) the Created By (Private List) check box.
[image: image86.png]Modify Form x

Form Name: | Defauit Attendse Form

Attendee Search Form Fields
[] Field Label

‘Attendee Type
Last Name
First Name
Attendee Tite.

Company.

Total Amount Previous Year
Employee Amount YTD.
Total Amount YTD

Project D





110. Click Save.
IMPORTANT: SYSEMP with Non Employees
The Employee (SYSEMP) attendee type is used to automatically add employees to a client's attendee list – so users can quickly find other employee attendees. In some cases, company requirements drive the creation of user accounts for people who are not employees of the company, such as contractors. 

Due to regulatory and client requirements, there must be a way to clearly define the precise and correct attendee type for the user who is not an employee. The solution is to use a profile (employee) field to indicate which users are not employees. Users who are not employees will:

· Not be automatically added to the Employee Attendee type

· Not be searchable via the Employee attendee type

· Not be automatically added as an attendee for an expense type configured to do so for employees

Configuration – Client

Clients interested in using this feature must contact SAP Concur support for assistance. Concur will add the Is Non Employee field to the profile (employee form) as described below.

Then, the client can:

· Use its own internal resources to determine which Concur Expense users are non-employees

· Access User Administration to select (enable) the Is Non Employee field for each non-employee

NOTE: The Is Non Employee field is not available in the user import.

Configuration – Concur

Concur will follow the configuration/activation steps noted below. The process is to add the new Is Non Employee field to the employee form and then make the field modifiable by the Employee Administrator.

111. Click Administration > Expense > Forms and Fields.
112. In the Form Type list, click Employee.

113. Click the Form Fields tab.

114. Click Add Fields.
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115. Select the Is Non Employee field.

116. Click Add Fields. The Is Non Employee field now appears on the employee form.

117. To ensure that the field is modifiable by the Employee Admin, double-click the Is Non Employee field. The Modify Form Fields dialog appears.
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118. In the Employee Administrator Role list, click Modify.

119. Click Save.

Step 7: Create Attendee Audit Rules

You can create audit rules that allow you to flag attendees, for example, for:

· The total amount spent, per expense type, on any attendee, totaled either company-wide or by the current employee

· The frequency (per month, quarter, or year) at which any individual has been named an attendee, either company-wide or by the current employee 

Amount and frequency totals that apply to the current employee are stored with the expense entry. Amount and frequency totals that apply to the entire company are stored with the expense entry and the attendee record.

Refer to the Concur Expense: Audit Rules Setup Guide.

Step 8: Configure for Personal Attendee Import

In order to activate this feature (and configure the required template), the administrator must have the Concur Expense Configuration Administrator (Restricted) or the unrestricted Concur Expense Configuration Administrator role assigned in Concur Expense.

Overview: Personal Import

These are the steps in the configuration process:

Part 1: Initiate the process to generate a basic template worksheet.

Part 2: Edit the template, for example, to account for list data.

Part 3: Upload the completed worksheet.

Once the completed worksheet is uploaded, the Import button appears in the Attendees section of the New Expense (or Expense) tab, ready to be used.

Procedure: Part 1 – Generate the Basic Template

 To generate the base template:

120. Click Administration > Expense. 
121. Click Attendee Import Templates. The Excel Templates For Attendee Import page appears.
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122. Select the desired language (the language in which the template will be generated), and click Generate Base Template.
NOTE: The import file template is language-specific. The administrator must create a template for each language that is in use by the company.

123. Take the necessary steps (depending on browser) to save the template to your local computer or network.
· IMPORTANT: The generated base template file is an Excel 97-2003 Workbook (*.xls file format). Please ensure that this format is maintained, and the template uploaded for your company to use is in this same file format.
124. Repeat this process for each required language.

Review the Template Worksheet

Open the worksheet file. 
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Each Excel file has at least one worksheet (tab). The first sheet is named Attendees. Any other sheets that may appear contain drop-list data. 

On the Attendees sheet:

· Row 1 shows the field codes
· Row 2 shows the client-defined field names
· Row 3 - 65,536 are the rows in which the user will type

Procedure: Part 2 – Edit the Worksheet

Row 1 (Field Codes)

Do not edit any of these cells. If any of these cells are changed, the import will fail. During the configuration process, you will use these field codes and any additional worksheets to create the drop-list fields. 

Row 2 (Field Names)

These are the field names (column headers) that will display to the user. The main editing task involves required fields.

 To work with row 2 (field names):

You must:

125. Access Concur Expense and view the Attendees section of the New Expense (or Expense) tab to see which of the attendee fields are required.

126. Mark the required fields. You can solve the problem as simply or as intricately as you want. Two suggestions are:

· If you are not concerned about users using the optional fields, then hide the optional columns so only the required columns appear. Instruct users to complete all fields.
- or -
· Edit the labels of the required fields to include "REQUIRED"
Example: REQUIRED Last Name

Row 3 through 65536 (Data)

These are the cells in which the user will type or select (drop-list) attendee data. The editing tasks involve list data and other field formatting.

NOTE: Any change/edit you make in any column must apply to each row from Row 3 to Row 65536. This ensures that – no matter how many rows the user wants to use – they are always using a formatted row.

 To manage the list data:

127. Review the list data shown on the other worksheets (tabs), if any. The name on the worksheet tab matches the field code (Row 1). 

This template worksheet provides only the first 100 items for each list. So:

· If less than 100 items appear for a list, then assume that all available list items are provided for that list. 

· If exactly 100 items appear, then assume that there are more list items. You can:

· Add the remaining list items by typing them into the Excel sheet manually, or

· Submit a service request to SAP Concur support to obtain a full copy of the list. The information you receive can then be copied and pasted into Excel.

NOTE: If you change attendee-related list data frequently in Concur Expense, you must also update this worksheet for each change. Another option is to set this field as a text field, with a comment instructing users how to correctly enter the appropriate option.

128. Configure these rows with drop-lists. Instructions are provided in Create Drop Lists in Excel. 

 To deal with other formatting: 

It is not likely that the template will require other formatting (such as numeric only or field length restrictions) in the attendee fields. However, to be sure: 

129. Access Concur Expense to identify any other applicable field formatting.

130. Format the worksheet to match those formatting requirements.

· IMPORTANT: For these fields, you can solve the problem as simply or as intricately as you want but do not enter text in these cells. 

Final Editing Step

 To hide the field codes and "list" sheets:

When all formatting is complete, hide – do not remove – the field codes (Row 1) and the sheets (tabs) that contain the list data. 

131. To hide the field codes (Row 1):
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· Select the first row.

· On the Home tab, click Format > Hide & Unhide > Hide Rows.

132. To hide the worksheet(s) with the list data:
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· Select all sheets except the first one (Attendees).

· On the Home tab, click Format > Hide & Unhide > Hide Sheet.
Tip: Just before saving for the last time, click in cell A3 and then save. The next time the worksheet is opened, A3 will be selected. Since A3 is likely a list, the down pointing arrow appears, making it easy for the user to identify this field as a drop-list.
Tip: After saving the file, close it and open it again to test that all changes were successfully saved in Excel 97-2003 Workbook (*.xls file format) before uploading the template. Incompatible configuration will be removed from the file on save.
Procedure: Part 3 – Upload the Customized Worksheet

 To upload the sheet:

133. Return to the Excel Templates For Attendee Import page as described previously.

134. Click Upload Template.
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135. Click Browse (or Choose File depending on browser) and locate the customized worksheet.

NOTE: If you have multiple languages, you must first select the language in the drop list and then upload the template for that language.  
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136. Click Upload Template. The new template appears.
[image: image95.png]Excel Templates For Attendee Import

Attendee Import Templates

Select Language:
| Engiisn[]| Generate Base Template ~ Upload Template  View Templates

AVAILABLE TEMPLATES

Action Language

View Delete English





At this point, the Import button will be available for users in the Attendees section of the New Expense (or Expense) tab for that language.
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Follow these same steps for all templates for all desired languages.

Procedure: Create Drop Lists in Excel

This information applies to Microsoft Excel 2010. If you have a different version of Excel, search for "drop-down list" in Excel's online help.

 To add the drop-list for the list data:

137. Click the sheet (tab) that contains the list data, in this case, AtnTypeKey.

138. Select the list data.
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139. In the name box, type a range name, such as AttType, and press Enter.
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140. On the Attendees tab, click cell A3.

141. On the menu, select Data > Data Validation. The Data Validation dialog box appears.
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· In Allow, select List.

· In Source, type =<range name>. In this case, =AttType. 
Hint: Don't forget. The range name starts with =

· Click OK.

142. Copy A3 to cell A4 through A65536. 

Tip: To copy from A3 to the end of the column:

· Click in A3

· Copy

· Click in A4

· Press CTRL + SHIFT + down arrow

· Paste

143. Complete these same steps for all lists.

Step 9: Import a List of Attendees

You can import a list of attendees for your company, for example, your company's client list or list of employees. This way, they appear in the Attendees list so users do not have to enter them manually (and perhaps inconsistently). You can also use the import feature to change attendee information or delete attendees.

To import a list of attendees, refer to the Shared: Attendee Import, Version 2 Specification.

IMPORTANT! Using the Attendee Import on an Existing System

If you are planning to use the attendee import on an existing system (already has attendees), refer to Implementing the Attendee Import on an Existing System - Tips and Hints.

External ID - Required for Imported Changes and Deletions

The External ID is required in order to make changes to attendees (edit or delete) via the import. In most cases, the External ID is a company-generated unique identifier, which is imported with the initial import of attendees. However, for attendees who are manually entered by Concur Expense users, there likely is no External ID. Without that information, you cannot change or remove those attendees via the import.

To solve this problem, you can have the system auto-generate an External ID for each attendee so that the External ID will never be blank. 

Configuration

To activate this feature, select Generate an External ID when a new attendee is created by a user on the Settings tab of the Attendees page.
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Extract the External IDs

Then, to obtain the External IDs for all attendees (so you can use them in an import), collect them from the Standard Attendee Detail Extract:

· If the Standard Attendee Detail Extract is already turned on for your company, the file will be available with your other extract files.

· If not, contact SAP Concur support to have it turned on.

Refer to the Shared: Attendee Import, Version 2 Specification.

Section 7:  Retain Attendee History with the Associated Expense Entry

Overview

By default, historical attendee information is not captured; only the current attendee information (master record) is available. Using the configuration steps described here, the point-in-time attendee information can be saved with the associated expense entry. 

Attendee information (such as name or title) can change over time. With this feature, once the attendee is attached to an expense entry, that attendee information is stored and not allowed to be changed when the master record changes.

Requesting a Configuration Change

To request a change to this configuration, please submit a change request to Concur Support.
Section 8:  Implementing the Attendee Import on an Existing System - Tips and Hints

Changing from a User-Entered List to a Managed List of Attendees

In existing systems (not yet using the import), it is likely that each Concur Expense user entered a record for every attendee the user wanted to use, including the Concur Expense user. This means that it is highly likely that many of the attendees you want to import from another application already exist within the system – and many will exist multiple times. 

To start fresh with a new list of attendees from the imported list, follow these steps:


	Step #
	Description
	Where to find more information

	1
	Define the name of the attendee type for this list. Attendee type names must be unique. 

Tip: If you want the same name as the existing attendee type, we recommend that you rename the existing attendee type and then create a new attendee type with the desired name.
	Procedure: Configuring Attendee Types in this guide

	2
	Determine if users will be allowed to add new attendees to the attendee type list. If you want to control this list, you may wish to turn off the users' ability to add new attendees.
	

	3
	Create the import file and import the list of attendees.
	Shared: Attendee Import, Version 2 Specification

	4
	Inactivate the old attendee type. This will remove all attendees of this type from all users' lists of attendees, though the information will still be viewable on expenses using those attendees.
	Procedure: Configuring Attendee Types in this guide


Changing Employees as Attendees to a Managed List of Attendees

There are two employee-related attendee types:

· Employee: In older versions, each Concur Expense user had to enter a record for every employee attendee the user wanted to use, including the Concur Expense user. This means that it is highly likely that many of the employee attendees already exist multiple times within the system. 

· This Employee: The system will automatically generate a record for each Concur Expense user but only once the employee takes one of these actions:

· The employee opens a new expense form where the employee is required to be added by default.

· The employee completes a 'This employee' attendee type search from the Attendee section of the New Expense (or Expense) tab or from profile.

· The employee completes a quick search or a favorite search from the Attendee section of the New Expense (or Expense) tab or from profile.  

To make this list a comprehensive and usable list of employees that can be shared by all for use on expenses, follow these steps:


	Step #
	Description
	Where to find more information

	1
	Create an import file containing data for the employee attendee records and import the list. This will provide records for those employees who have not yet accessed the Attendee section as well as provide additional details in each employee attendee record.

When creating the import file:

· The External ID for these records must be the Employee ID that appears in Concur Expense.

· The Attendee Type Code must be SYSEMP.

NOTE: Consider importing all employees who will be used as attendees – not only those who use Concur Expense. This will provide a comprehensive list of employee attendees for your Concur Expense users to search and select from. Then, if the imported employees who are not yet Concur Expense users become users in the future, the Employee ID will be used to link the attendee-related information to the correct user.
	Shared: Attendee Import, Version 2 Specification

	2
	Configure the This Employee attendee type:
	

	
	· Change the name if desired. 

Attendee type names must be unique. If you want the same name as the existing Employee attendee type, then you must rename the existing Employee attendee type first and then change This Employee to Employee.
	Procedure: Configuring Attendee Types in this guide

	
	· Configure the This Employee attendee type as a shared list by removing the Created By field in the duplicate check field.
	Private vs. Shared Attendee Lists and Procedure: Configuring Attendee Forms and Fields in this guide

	3
	Inactivate the old Employee attendee type. This will remove all attendees of this type from all users' lists of attendees, though the information will still be viewable on expenses using those attendees. Users creating new expenses will search for and use employee attendee records under the new This Employee attendee type.
	Procedure: Configuring Attendee Types in this guide

	4
	Change the new Employee attendee type to a shared list.

· Change the form fields for search - clear the Created By (Private List) check box

· Edit the duplicate check - clear the Created By (Private List) check box
	Private vs. Shared Attendee Lists in this guide


Section 9:  Appendix – Special Situations/Forms/Fields

Fields: Special Conditions for Selected Fields
Report Key
The Report Key field is intended for use by the Concur Expense Processor when troubleshooting issues from the integration with accounting systems (Standard Accounting Extract or Financial Integration). SAP Concur does not recommend that it be used in employee- or approver-facing UIs, and strongly recommends that the Report ID is used in all scenarios that require an identifier for the specific expense report.
☼
Applies to these SAP Concur solutions:


( Expense�( Professional/Premium edition�( Standard edition


( Travel �( Professional/Premium edition �( Standard edition


( Invoice�( Professional/Premium edition �( Standard edition


( Request�( Professional/Premium edition�( Standard edition
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